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Vielen Dank, dass Sie sich für ein GOSSEN Produkt entschieden haben! 
Genießen Sie die einfachen Bedienung, die hohe Qualität und präzise Messung sowie 
die vielfältigen Einsatzgebiete. 

 

GL SPECTROSOFT BASIC ist eine Bedien- und Auswertesoftware für MAVOSPEC mit 

Standardfunktionsumfang.  

 

GL SPECTRASOFT BASIC Funktionsumfang: 

 Spektrale Leistungsverteilung – Grafische Anzeige des Spektrums mit 
Skalierungsfunktion und Farbzuordnung zu Wellenlängen 
 

 Tabellarische Messwertanzeige – Tabelle mit spektralen Daten in nativer oder 
berechneter 1 nm, 2 nm, 5 nm Schrittweite 
 

 Auswertung der Spektren – Berechnung von lichttechnischen und farbmetrischen 
Größen, Farbort (XYZ; x,y; u´v´; CIELab), korrelierende Farbtemperatur, 
Farbortfehler, Peakwellenlänge und Wert, dominante Wellenlänge, 
Farbwiedergabeindex Ra und Einzelindizes R1 bis R14 
 

 Anzeige des Farborts - in der CIE Normfarbtafel , CIE 1931 [x, y], CIE 1960 [u, v] 
oder CIE 1976 [u´, v´] bei auswählbarem 2° oder 10° Normbeobachter 
 

 Lichttechnische Grundgrößen – je nach angeschlossenem Zubehör wird 
Beleuchtungsstärke, Leuchtdichte oder Lichtstrom aus dem Spektrum berechnet. 
 

 Personalisiertes Messprotokoll – kann für Dokumentationszwecke von der gerade 
angezeigte Messung als HTML Seite erstellt werden. 
 

 Fernsteuerung und Datenübernahme – des MAVOSPEC über USB oder WiFi 
Schnittstelle. Einzelne, kontinuierliche oder intervall-gesteuerte Messungen werden 
unterstützt. 
 

 Universelle Austausch von Spektren – extern erzeugte Spektren können aus TXT 
Dateien importiert und dann ausgewertet werden. Interne Daten können über TXT 
Dateien oder Clipboard exportiert und mit anderen Anwendungen weiterverarbeitet 
werden. 
 

 Individuell gestaltbarer Desktop – einzelne Fenster können beliebig angeordnet, 
skaliert, zusammengestellt und als Konfiguration abgelegt werden. 
 

 Internationaler Einsatz – Menüführung umschaltbar zwischen den Sprachen 
Deutsch, Englisch, Französisch, Italienisch und Polnisch. 
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GL SPECTROSOFT PRO ist eine Bedien- und Auswertesoftware für MAVOSPEC 

mit erweitertem Funktionsumfang. Sie beinhaltet alle Funktionen der Software GL 

SPECTROSOFT BASIC. 

 

GL SPECTRASOFT PRO erweiterter Funktionsumfang: 

 Binning von Leuchtdioden – mit dem eingebauten Editor können Helligkeits- und 
Farbbins festgelegt werden. Bei der Messung einzelner LEDs werden diese in die 
definierten Klassen eingeteilt. 

 

 Metamerie Indizes – werden für den UV und VIS Bereich ermittelt. 
 

 Abnahme von Abmusterungsplätzen – die nach ISO 3664 erforderlichen 
Messgrößen werden in einem Prüfablauf ermittelt und ein Abnahmeprotokoll 
erstellt. 
 

 Lichtstärke (cd) – Berechnung der Lichtstärke über die Beleuchtungs-
stärkemessung mit Standarddiffussor und Vorgabe des Abstands. 
 

 Transmission und Reflexion – von optischen Komponenten kann mit einer 
externen Lichtquelle und optischen Messzubehör realisiert werden. 
 

 Messwerte auf einen Blick – auswählbare Messgrößen können in einem 
speziellen Fenster angezeigt werden. 
 

 Übersichtlicher Vergleich – auswählbare Messgrößen verschiedener 
Messungen können in einer Tabelle zusammengefasst und in einem speziellen 
Fenster angezeigt werden. 
 

 MacAdam Ellipsen – in Vorbereitung 

   

i 
Falls Sie weitere Anforderungen bezüglich des GL SPECTROSOFT haben, wie z.B. 

spezielle Funktionen für Ihren Mess- und Prüfprozess, spezifische Berichte oder weitere 

Messgrößen, die anhand des Spektrums berechnet werden, fragen Sie uns bitte nach 

kundenspezifische Adaptationen. 
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1 Einleitung 

GL SpectroSoft ist eine optionale, intuitiv bedienbare Auswertesoftware mit 
umfangreichen Messfunktionen zur Spektralanalyse von Lichtquellen sowie 
Transmissions- und Reflexionsmessung. Sowohl spektrale Messwerte aus dem 
MAVOSPEC mit jeweiligem Zubehör als auch extern erzeugte Spektren sind nach 
aktuellen CIE Normen auswertbar. Die Software berechnet farbmetrische Größen wie 
Farbort nach verschiedenen CIE Standards, ähnlichste Farbtemperatur, Farbortfehler, 
Peakwellenlänge, dominante Wellenlänge, Farbwiedergabeindex, Metamerieindex. 
Erweiterungen wie scotopische und fotopische Werte, PAR und PPFD Werte, 
MacAdam Ellipsen können auf Kundenwunsch realisiert werden. 

 

Die Software GL Spectrosoft ist hervorragend geeignet für allgemeine 
Lichtbegutachtungen, für Laboranwendungen und zur Qualitätssicherung in der 
Produktion. Der konfigurierbare Desktop kann an die jeweilige Messaufgabe angepasst 
werden und liefert übersichtlich nur die benötigten Informationen. Je nach Anforderung 
sind unterschiedliche Programmversionen verfügbar. 

 

1.1 Systemanforderungen 

 
Die folgenden Voraussetzungen müssen erfüllt sein, um GL SpectroSoft auf Ihrem PC 
zu nutzen: 

 

 IBM oder 100% IBM-kompatibler PC 

 Ihr PC muss über einen USB-Eingang verfügen. 

 Betriebssystem Microsoft Windows (alle Servicepakete müssen installiert sein.) 

 Windows XP und XP x64 

 Windows Server 2003 und Server 2003 x64 

 Windows Vista und Vista x64 

 Windows Server 2008 und Server 2008 x64 

 Windows 7 und 7 x64 

 Windows Server 2008 R2 

 Windows 8 und 8 x64 

 Die Installation ist unter allen anderen Betriebssystemen nicht möglich. 

 Ungefähr 4 MB freier Speicherplatz auf der Festplatte für die GOSSEN-Software 
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1.2 Lizenzarten 

Die GL SPECTROSOFT-Software ist in den drei Versionen verfügbar: BASIC, PRO und 
LAB. Sie können auch die PRO-Version durch Einzelfunktionen erweitern, die bei der 
LAB-Version verfügbar sind. Sie können auch Versionen erweitern und ändern, indem 
Sie entsprechende Lizenzschlüssel hinzufügen.  

  

GL SPECTROSOFT Lizenzliste und Softwareoptionen 

Lizenz- 

name 
Optionen Beschreibung 

BASIC 

(CRI) 

SPD Grafische Spektrendarstellungen 

Results Window 
(Ergebnisfenster) 

Berechnung folgender fotometrischer Ergebnisse: 

- Farbkoordinaten gemäß Beobachter CIE 1931 2ᵒ 
- Farbkoordinaten gemäß Beobachter CIE 1964 10ᵒ  
- Farbwiedergabe-Indizes Ra , R1 – R14 
- Chromatizitätsfehler 
- Farben-Peak 
- Farbdominante 
- Lambda 2 ( FWHM ) 
- Reinheit 

 

 Measurement-Fenster 
(Messwertfenster) 

Spektrumsdaten in nativer oder berechneter 1nm, 2nm, 5nm 

Schrittweite  

Export / Import Funktion für Datenexport/-import im TXT-Format 

Report 

(Bericht) 

Editor zur Erstellung von Bereichten nach der Messung 

Chromaticity charts 

(Farbdiagramme) 

Farbdiagramme gemäß CIE 

- 1931 (x y) 
- 1960 (u v) 
- 1976 (u’v’) 

 

PRO
1
 

SELECTED RESULTS 

(AUSGEWÄHLTE 

ERGEBNISSE) 

Zusatzfenster zur Anzeige ausgewählter Ergebnisse 

COMPARISON WINDOW 

(VERGLEICHSFENSTER) 

Zusatzfenster zur Anzeige der gesamten Messungen 

BINING TOOL 

(BINNING-WERKZEUG) 

Editor zum Einstellen der Helligkeit- und Farbklassifizierung 

ISO evaluation  

(ISO-Bewertung) 

Messprotokoll gemäß ISO 3664-Standard 

MI-Berechnung Metamerieindizes im UV- und VIS-Bereich 

INTENSITY [cd] Ermöglicht die Berechnung der Intensitätswerte mithilfe des  

Standarddiffusors und der Eingabe der Entfernung. 

MacAdam erscheint demnächst 
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1 Die PRO-Lizenz ist ein Upgrade von BASIC und umfasst alle Merkmale von BASIC 
und einen vollständigen Satz zusätzlicher, beschriebener Funktionen. 
2 Individuelle Funktionen von LAB können separat bestellt und der PRO-Lizenz 
hinzugefügt werden, oder eine vollständige LAB-Lizenz wird als ein Paket angeboten. 

 

 

2 Installation 

Diese Laborsoftware dient zur umfassenden Spektralanalyse. Entsprechend der 
Version, die Sie erworben haben, können Sie auf eine bestimmte Anzahl spezieller 
Daten für Spektralmessungen zugreifen. 

Vor dem Start der Installation stellen Sie bitte sicher, dass  

 das Betriebssystem des verwendeten Rechners auf dem aktuellen Stand ist, 
d.h. alle Servicepakete und verfügbaren Updates installiert sind 

 sie die Administratorrechte haben 

 der Virenscanner für die Dauer der Installation abgeschaltet ist 
  

 Transmission, Reflection 

(Transmission, Reflexion) 

Diese Softwareoption kann zu Übertragungs- oder 

Reflexionsmessungen bei lichttechnischen Komponenten 

benutzt werden. Sie ermöglicht Referenzmessung und 

danach T- oder R-Messung des Musters mithilfe einer 

externen Lichtquelle und von optischem Zubehör. 

Scotopic / Photopic Option zum Berechnen von S/P-Werten 

LAB
2 

TIMER/SERIAL Produkt – 

Nr. 

Festlegen des automatischen Messplans. Set 

RELATIVE 

Messungs-

vergleich 

Produkt – 

Nr. 

Gestattet Referenzmessungen und Vergleich anderer 

Messungen mit Referenzmessung. Option zur Anzeige 

prozentualer oder realer Wertänderung.  

PASS/FAIL Produkt – 

Nr. 

Editor für Wahl einer Anzahl von Parametern als Kriterium 

für Pass / Fail-Auswahl 

RANGE Produkt – 

Nr. 

Gestattet die Änderung des Spektralbereichs in dem 

Messergebnisse berechnet werden.  

AMBIENT Produkt – 

Nr. 

Mit dieser Funktion wird der Einfluss des Umgebungslichts 

kompensiert, wo Messungen vorgenommen werden. Der 

Messwert von Umgebungslicht kann vor der Prüfmessung 

festgestellt werden. 

PPFD/PAR 

[µmol] 

Produkt – 

Nr. 

Berechnung der Photonenflussdichte und fotosynthetisch 

aktiver Strahlung 

CALIB 
Verfügbar nur als Zusatz 

für PRO- oder LAB-Lizenz 

Software für Kalibrieren von Beleuchtungsstärke, 

Lichtstrom und Helligkeit von GL Optic-Geräten 
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Zum Start der Installation benutzen Sie lediglich das Setup-Programm 
GL_SpectroSoft v----.exe von Ihrer CD. Das Installationsprogramm führt Sie durch 
den Installationsprozess. Der Installationspfad ist so ausgelegt, dass künftig  Fern-
Upgrades möglich sind. 

HASP Key 

Nach erfolgreicher Installation der Software stecken Sie den HASP Key in den USB-
Port an Ihrem PC. Dieser Dongle enthält die Schlüsselinformationen (Key) für Ihre 
Software, ohne die Sie GL_SpectroSoft nicht anwenden können. Warten Sie einige 
Sekunden ab, nachdem Sie den Dongle an Ihren PC angeschlossen haben, während  
Windows ihn installiert. Wenn der HASP Key installiert ist, leuchtet die LED auf. 

 

2.1 Anschluss von Geräten 

 
Mithilfe folgender Treiber ermöglicht die GL SPECTROSOFT-Software den Anschluss 
verschiedener Gerätetypen: 
 
- SPX Driver (GL SPECTIS 1.0, GL SPECTIS 8.0) 
- Android USB Driver (MAVOSPEC, GL SPECTIS 1.0 Touch, GL SPECTIS 5.0 Touch) 
 
Im Installationsprozess kann der Benutzer eine der Installationsarten auf dem 
Bildschirm Select Components auswählen: 
 
-  GL SPECTROSOFT für GL SPECTIS 
-  GL SPECTROSOFT für GL SPECTIS Touch 
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2.1.1 GL SPECTROSOFT für GL SPECTIS 
 
Es ist nur GL_Spectrosoft installiert. Sollten Sie Geräte nutzen die den SPX-Treiber 
benötigen (GL SPECTIS 1.0, GL SPECTIS 8.0) dann muss der SPX-Treiber zusätzlich 
installiert werden. Die Software ist für den Betrieb von Geräten mit dem SPX-Treiber 
ausgelegt. 
 
2.1.2 GL SPECTROSOFT für MAVOSPEC 
 
GL_Spectrosoft und Android USB-Treiber sind installiert. Bei diesem Installationstyp ist 
die Software für den Betrieb von Geräten mit Android USB Driver (MAVOSPEC) über 
USB-Kabel eingerichtet. 
 
2.1.3 GL SPECTROSOFT für mehrere Geräte 
 
Wenn Sie mit verschiedenen Geräten arbeiten die alternativ den SPX und Android-
Treibern verwenden: 
1. Installieren Sie GL SPECTROSOFT für GL SPECTIS Touch. 
2. Installieren Sie den SPX-Treiber. 
3. Wählen Sie Device im GL SPECTROSOFT-Hauptmenü File->Settings 

 

 

 

Verbindungsarten: 

 

1. Spectis – Verbindung über SPX-Treiber (Spectis 1.0, Spectis 8.0). 

 

TCP-Verbindung über SPX-Treiber. Der SPX-Treiber muss installiert und gestartet 
werden. Geben Sie die IP-Adresse eines PC mit SPX an und das verbundene Gerät. 
Verwenden Sie die Standardeinstellungen für den Anschluss an demselben PC.  

 

2. MAVOSPEC – Verbindung mit  Android-Gerät 

 

Der Anschlusstyp MAVOSPEC kann mithilfe des Device Preferences Fensters 
festgelegt werden. 

 

Ausgewähltes  Gerät 

Auswahl Button 
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3. MAVOSPEC - WiFi – Anschluss über WiFi-Treiber 
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TCP-Anschluss über WiFi. Stellen Sie die IP-Adresse eines MAVOSPEC Geräts in den 
Settings ein (z.B. 10.0.6.123 auf dem Bildschirm unten). 

 

 

 

 

 

 

 

 

4. MAVOSPEC - USB – Anschluss über Android USB-Treiber 
 
Der Anschluss erfolgt über USB-Kabel. Der Android USB-Treiber muss installiert sein. 
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2.2 Änderung oder Erweiterung der Lizenz  
 
Wählen Sie File->Licence aus dem Hauptmenü, um die Softwarefunktionen mit einem 
Lizenz-Key zu erweitern. 
 

 

 

Ändern der Lizenzversion 

 

 

 

So ändern Sie Ihre Softwareversion (z.B. Erweiterung von der Basic-Version auf Pro) : 

1. Kopieren Sie den Code der Lizenzversion in das Feld License key , oder laden Sie 
ihn von einer Datei mittels des Buttons  Load from file  

2. Drücken Sie zur Bestätigung den Button OK unten.  

3. Starten Sie das Programm neu. 

 

Nach dem Neustart der Software steht die neue Version zur Verfügung. 
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Lizenz für Zusatzfunktionen 
 
Um neue Funktionen zu Ihrer Software hinzuzufügen:  
 
1. Schließen Sie das Gerät an und nehmen mindestens eine Messung vor. 
2. Erzeugen Sie einen Request Code – dieser erscheint im Feld Request code. 
3. Speichern Sie den Request Code mit dem Button Save to file und senden Sie ihn an 
Ihren Vertriebspartner. 
 
 

 
 
 

4. Holen Sie sich einen zusätzlichen Funktionscode von Ihrem Vertriebspartner, und 
laden Sie den Code mittels  Load licence from file (im Feld Additional function code  
erscheint ein Code). 
 

 

 
5. Fügen Sie mit dem Button Add licence key einen Lizenzschlüssel hinzu. 
6. Starten Sie das Programm neu.  
 
Nach dem Neustart des Systems stehen die neuen Funktionen zur Verfügung. 
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3 Start des Programms 
 

Messung und Analyse mit der Software GL SPECTROSOFT  
 
Betriebsstart 
 

1. Schließen Sie Ihr Messgerät über ein USB-Kabel an Ihren Computer an.  
2. Starten Sie die SPX-Treibersoftware (nur bei Spectis Touch 1.0 oder 8.0).  
3. Wählen Sie einen Gerätetyp in File->Settings (das Standardgerät hängt davon 

ab, welches Gerät bei der Installation gewählt wird). 
4. Stecken Sie den HASP USB Key (Dongle) ein, und warten Sie einige Sekunden, 

bis  das System den Schlüssel installiert hat.   
5. Nun können Sie die GL SPECTROSOFT starten. 

 
In der oberen linken Ecke steht eine Beschreibung der derzeit verwendeten 
Programmoptionen. Darunter finden Sie die Symbolleiste für alle Programmfunktionen.  
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4 Symbolleiste für Grundfunktionen 

Je nach der Version / Lizenz des Programms kann auf verschiedene Funktionen 

zugegriffen werden. 
 

   1.    2.       3.      4 .     5.     6.            7.       8.    9.   10.  11.  12.  13.  14.  15. 

 

 

1. Open: Zuvor gesicherte Messungen können geöffnet werden. 

2. Save group: Alle derzeit offenen / aktiven Messungen können in einer Datei 

gesichert werden. 

3. Zoom max: Damit wird die Ansicht des gesamten Spektrumdiagramms im 

hinsichtlich der aktuellen Fenstergröße optimiert. 

 a) Mithilfe des Mausrads können Sie die Spektrumdarstellung zoomen (+/-). 

 b) Halten Sie Y, und ändern Sie mit dem Rad die Ansicht auf der Y-Achse.  

 c) Halten Sie X, und ändern Sie mit dem Rad die Ansicht auf der X-Achse. 

 d) Klicken Sie zweimal auf das Chart-Feld, um die Ansichtsoptionen auf     

     maximalen Zoom zu setzen. 

4. Measure: Messungen durchführen, oder einfach die Leertaste betätigen. Zusätzlich 
hat das MAVOSPEC eine seitliche Messtaste.  
 

5. Continuous: Kontinuierlich Messmodus mit vorgegebenen Parametern Mess-
interval und Anzahl der Messungen. Damit können Änderungen am Spektrum unter 
bestimmten Bedingungen ständig überwacht werden. Um den Modus zu beenden, 
ist Continuous erneut anzuklicken. 

6. Serial measurement interval. Ermöglicht eine Serie von Messungen im eingestellten 
Zeitintervall. (siehe auch Kapitel ”Serielle Messungen”). 

7. Serial measurement count. Ermöglicht eine eingestellte Anzahl von Messungen. 
(siehe auch Kapitel „Serielle Messungen”). 
 

8. Config: Der Button dient für die Einstellung der grundlegenden Parameter der 
Messungen, wie z.B.: 

 a) Integrationszeit 

 b) Anzahl von Messwiederholungen 

 c) Pfad zur Datensicherung  

 d) Bereich für Spektralmessung 

9. Temperaturanzeige 

10. Signalpegelanzeige  
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11. Transmissions- / Reflexions-Modus 

 

 

 

Dieser Modus gestattet es, vergleichende Messungen durchzuführen. Die 
Referenzmessung wird mit dem REF-Button gestartet. Die nächste, mit dem M-
Button ausgelöste Messung wird mit der Referenzmessung verglichen, und die 
Signaldaten werden als Prozentwert des Referenzsignals angezeigt.  

 

12. Background kennzeichnet eine aktuelle Messung als Messung des Umgebungs-
lichts. Der nächste Benutzer kann mithilfe des Kontextmenüs ein ausgewähltes 
Hintergrundsignal zwecks Kompensation des Umgebungslichts von einer anderen 
Messung abziehen. Als Ergebnis wird ein weiterer Tab für ein Signal mit 
abgezogenem Umgebungslicht erzeugt. Diese Funktion ist nützlich, wenn Sie 
Umgebungslicht während des Messvorgangs nicht vollständig eliminieren können. 

 

13. Background const wirkt in ähnlicher Weise wie die Background-Funktion, aber das 
markierte Umgebungslicht wird nach der Messung abgezogen, und das Endsignal 
nach dem Abzug wird sofort dargestellt. 

 

14. Relative kennzeichnet eine aktuelle Messung als Referenzsignal. Wenn der 
Benutzer dann den Button Relative View benutzt, kann er nachverfolgen, wie sich 
die fotometrischen und radiometrischen Parameter des Signals verändern. Im 
Ergebnisfenster (Results) werden die Parameterunterschiede angezeigt. 

 

15. Relative view – An/Ausstellen der relativen Ansicht im Ergebnisfenster, wenn der 
Relativmodus aktiv ist. 
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4.1 Serielle Messungen 

 

 

 

 

 

GL_SpectroSoft ermöglicht es, serielle Messungen in einem bestimmten Intervall 

und mit einer festgelegten Anzahl zu programmieren. 

1. Continuous – Mit dem Button werden kontinuierliche und serielle Messungen 

gestartet bzw. gestoppt. 

Bei der kontinuierlichen Messung (das Interval und die Anzahl sind auf 0 gesetzt) 

werden die Messungen nacheinander ausgelöst, und das Spektrum wird in 

demselben Diagramm angezeigt. Die Funktion ist nützlich, um eine Änderung der 

Spektrum- und Chromatizitätsparameter einer Lichtquelle zu verfolgen. 

Serielle Messungen werden auch durch den Continuous-Button ausgelöst, wenn das 

Intervall oder die Anzahl auf einen anderen Wert als 0 eingestellt sind. In diesem 

Fall werden die Ergebnisse in separaten Grafiken dargestellt. 

2. Interval – gibt das Intervall zwischen Messungen in Sekunden an. Die Messungen 

werden nacheinander ausgelöst, wenn das Intervall auf 0 eingestellt ist. 

3. Count – bezeichnet die Anzahl von durchzuführenden Messungen. Wenn der Wert 

auf 0 gesetzt ist, kann die Messschleife mithilfe des Continuous-Button gestoppt 

werden. Während der seriellen Messungen zeigt das Count-Feld die aktuelle Anzahl 

der durchzuführenden Messungen an.    

 

Das Programm gestattet es auch, eine Startzeit für serielle Messungen vorzugeben, 

einschließlich Intervall- und Messzählung. 

Die Einstellung kann über das Startmenü Action->Set continuous erfolgen: 

 

 

1. Start/stop 

 Serielle Messung 

2. Interval zwischen 

Messungen 

3. Anzahl der 

Messungen 
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5 Obere Menüoptionen 
 
Über die Buttons in der linken oberen Ecke des Bildschirms können Sie auf die übrigen 
Menüfunktionen zugreifen. 

 

 
 
5.1 File 
 

 
 
Open  - Öffnen zuvor gesicherter Messungen 
 
Open  - Öffnen nur einer Messung vom mehreren zuvor gesicherten  
group    Messungen 
 
Save group - Sicherung der aktuell offenen Gruppe von Messungen 
 
Save  - Sicherung nur der aktuell geöffneten Messung 
 
Import - Öffnen von Messungen anderer Programme die im Textformat 
   gespeichert sind. Die erste Spalte enthält die Wellenlänge, die zweite den 
   zugehörigen Messwert getrennt duch das Tabulatorzeichen. 
 
Export  - Sicherung der Daten im Textformat 
 
Export >Clipboard – Sicherung der Daten im System-Clipboard 
 
Report – Erzeugung des Messberichtes für die aktuell angezeigte Messung 
 
Language – Spracheinstellung 
 
Licence – Änderung oder Funktionserweiterung der Softwareversion (siehe auch 
Kapitel Lizenztypen) 
 
Settings – Zugriff auf zusätzliche Systemeinstellungen 
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5.2 ISO 3664 Assessment (Farbbeurteilung) 
 
ISO 3664 assessment – ist ein Messverfahren gemäß der Norm ISO 3664:2000 für 
Sichtbedingungen in der Grafiktechnik und Fotografie. 
Hinweis: Bevor Sie dieses Verfahren starten, legen Sie die Messparameter für die 
Integrationszeit und die Anzahl von Wiederholungen fest.  
 
1. Zum Starten des Verfahrens gehen Sie in das obere Menü und klicken auf File, ISO 
3664; es erscheint das folgende Dialogfeld: 
 

 
 
2. Bestätigen Sie dieses Feld, und wählen Sie Größe der beleuchteten Oberfläche aus: 
 

 
 
3. Sobald Sie die entsprechende Norm auswählen, erscheint folgendes Fenster: 
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4. Bringen Sie MAVOSPEC in die angezeigte Position, und klicken Sie zweimal auf das 
Symbol, um die Messung vorzunehmen. Das Programm legt die nächste Messposition 
fest, auf die das Spektrometer zu setzen ist und wo die Messung erfolgen soll. Fahren 
Sie bis zum Prozessende fort. 
 
5. Nach Abschluss der Messungen an allen festgelegten Positionen erscheint das 
Dialogfeld, in dem die Prüfergebnisse angezeigt werden. 
 
6. Nach Abschluss des Messprozesses können Sie den Bericht erstellen. Zu diesem 
Zweck klicken Sie auf Report unten in der Darstellung der Messung. 
 
 
5.3 Edit 
 

 
 

Zoom in - hineinzoomen in ein Spektrumdiagramm 

Zoom out - herauszoomen aus einem Spektrumdiagramms 

Zoom max - optimiert Ansicht des Spektrumdiagramms auf Fenstergröße. 

Switch to left - schaltet Spektrumdiagramm auf die vorhergehende Messung 

Switch to right  - schaltet Spektrumdiagramm auf die nächste Messung  

Switch to the end - schaltet Spektrumdiagramm auf die letzte Messung 

Switch to all - zeigt alle Messungen im Spektrumdiagramm an 

Always zoom max - eine neue Messung wird immer optimierter Ansicht des 

     Spektrumdiagramms geöffnet. 

PPFD view  - ein-/ausschalten der Darstellung der photosynthetischen 

   Photonflussdichte (Hintergrund des Spektrumdiagramms 

   wechselt in diesem Modus auf hellgrün). PPFD bezeichnet die 

   Anzahl von Photonen im fotosynthetisch aktiven Bereich von 

   400nm-700nm,  die pro Sekunde auf einen Quadratmeter 

   treffen. 

Paint wavelengths  - ein-/ausschalten der Färbung des Spektrumdiagramm  
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5.4 Action 

 

 

Siehe Symbolleiste für Grundfunktionen. 

 

5.5 Window 

 

 

 

Save desktop  - sichern des aktuellen Desktop Layouts 

Open desktop  - öffnen eines zuvor gesicherten Desktop Layouts 

Measurement - anzeigen oder ausblenden von Messansichten 

Status 

Results 

CIE Chart 

Comparison 

Quick config 

Selected results 

Toolbar 
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6 Fenster der Messergebnisse  

6.1 Measurement 

Das Measurement-Fenster enthält die Ergebnisse für jede Wellenlänge. Benutzen Sie 

das Dropdown-Menü, um die Darstellung der Ergebnisse in speziellen Intervallen 

anzuzeigen: Original (Native) – die Quelldaten als 1nm, 2nm und 5nm; 

 

 

6.2 Status 

Das Status-Fenster zeigt die Systemdaten: die aktuellen Kalibrierdateien, ein 

verbundenes Gerät, die Koeffizienten u.a.   
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6.3 Results 

Das Results-Fenster beinhaltet die Ergebnisse der Messung gemäß dem  

2°-Beobachter (CIE 1931) und dem 10°-Beobachter (CIE 1964). 

 

In ihm wird auch Folgendes dargestellt: 

 Korrelierte Farbtemperatur einer Lichtquelle (CCT) – Kelvin-Wert 

 Chromatizitätsfehler 

 Peak Wellenlänge 

 Dominante Wellenlänge 
 
Abhängig von Softwareoptionen stehen folgende Berechnungen zur Verfügung: 
 

 Farbwiedergabeindex CRI 

 MI Metamerismusfaktor 

 Lichtstärke 

 Farbreinheit 

 Radiometrie 

 PPFD 

 PAR 

 Binning-Gruppe 

 Helligkeitsgruppe 
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6.4 Chart  

Das Chart-Fenster zeigt Grafiken in Form von CIE Chromazitätsdiagrammen an. 

Lesezeichen ermöglichen die Auswahl bestimmter Diagrammtypen. 

 

 

 

6.5 Selected Results 

Im Fenster Selected Results (Ausgewählte Ergebnisse) wird eine Zusammenfassung 
auswählbarer Messergebnisse dargestellt.  Um dieses Fenster anzuzeigen, klicken Sie 
auf die Symbolleiste und wählen "Selected results" aus. 

 

 

 

Nun erscheint das Fenster “Selected results”, und Sie können eine Auswahl der 
wichtigsten Messgrößen sehen. Um die Zusammenstellung der Messgrößen oder den 
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Schriftfont zu ändern, klicken Sie mit der rechten Maustaste auf das Fenster „Selected 
results” und es erscheint das Kontextmenü.  

 

 

 

Nun können Sie ein Template mit einer Anzahl von Parametern auswählen, die im 

Fenster „Selected results” angezeigt werden. 

 

 

Die Templates werden im Verzeichnis "C:\GL Optic\GL_Spectrosoft\tables\results" als 
Standardtextdateien mit den Parametercodes, die jeweils in einer neuen Zeile 
dargestellt werden müssen, abgespeichert. Leere Trennzeilen sind zulässig.  
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Beispiel: Die Datei "XYZ.txt" kann wie folgt aussehen: 
 
X2 
Y2 
Z2 
 
X10 
Y10 
Z10 
 
Liste der Codes, die in der Templatedatei der ausgewählten Ergebnisse benutzt werden 
können (in Abhängigkeit von der Version): 
x2, y2, u2', v2', L2, a2, b2, X2, Y2, Z2, x10, y10, y10, u10',v10', L10, a10, b10, X10, 
Y10, CCT, ChErr, ColPeak, ColPeakVal, ColDom, Purity, Radiometric, PAR, Ra, R1, 
R2, R3, R4, R5, R6, R8, R9, R10, R11, R12, R13, R14, Mivis, Miuv, Binning, 
Brightness. 
 

 
 

Die Codes entsprechen den Parametern, die im Results-Fenster dargestellt sind. 
 
Beispiel: 
 
x2 -  x CIE 1931 2˚observer, 
Y2 - Y CIE 1931 2˚ observer, 
x10 -  x CIE 1964 10˚ observer, 
Y10 - Y CIE 1964 10˚ observer, etc. 
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6.6 Comparison Table 

Das Fenster Comparison Table (Vergleichstabelle) gestattet den Vergleich von 
spektrometrischen Werten mehrerer Messungen in einer Tabelle. Das ist eine nützliche 
Möglichkeit, die dem Benutzer Standardfunktionen bietet wie z.B. das Festlegen 
benutzerdefinierter Wertesätze, Datensortierung, Export in Textdateien (durch Tabs 
getrenntes Werteformat) zur Verwendung in Fremdsoftware wie Tabellenkalkulation. 

 

 

 

Das Kontextmenü (rechte Maustaste) ermöglicht Funktionen in Verbindung mit der 
Vergleichstabelle aufzurufen. 

 

Export comparison - > txt – Tabelle in Textdatei exportieren (getrennt durch Tab)  

Export comparison - > Clipboard  - Tabelle in System-Clipboard exportieren 

Load table template  - Laden eines gespeicherten Tabellenlayouts  aus einer Datei   

Save table template  - Speichern eines Tabellenlayouts in eine Datei 

Remove columns  - Entfernen ausgewählter Spalten aus dem Tabellenlayout  

Add column – Hinzufügen von Spalten zum Tabellenlayout 

Default arrangement – Defaulteinstellung für Tabellenlayout 
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7 TOOLS 

7.1 Bin Editor 

Binning-Gruppen werden mit dem Bin Editor Tool definiert (Tools->Bin Editor). 
 

 
 

Im ersten Tab kann der Benutzer XY-Kriterien festlegen. Jede Zeile ist eine Definition 
für ein Polygon, wodurch die Position der X / Y-Parameter bestimmt wird. 
 

 
 
Bedeutung der Spalten: 
 
1. Gruppenname 
2. X-Koordinate des ersten Punkts des Polygons 
3. Y-Koordinate des ersten Punkts des Polygons 
4. X- Koordinate des zweiten Punkts des Polygons 
5. Y-Koordinate des zweiten Punkts des Polygons usw. 
6,7. Dritter Punkt 
8,9. Vierter Punkt 
 
Falls erforderlich können Sie mehr Punkte festlegen. 

 



 

GOSSEN Foto- und Lichtmesstechnik GmbH  30 

 

Die Definitionen von Binning-Gruppen können in einer Textdatei gesichert oder aus ihr 
geladen werden. Die Software benutzt stets die zuletzt benutzte Gruppe, deren Pfad 
über der Tabelle angezeigt wird. 
Manchmal ist es leichter, Binning-Gruppen direkt in einer Textdatei zu editieren oder sie 
dorthin zu importieren. 
 
Nachfolgend wird das Beispiel einer Textdateistruktur dargestellt: 
 
5U 0.437 0.389  
 0.442 0.398  
 0.448 0.400  
 0.443 0.391  
6U 0.442 0.398  
 0.447 0.408  
 0.453 0.409  
 0.448 0.400  
7U 0.447 0.408  
 0.451 0.417  
 0.458 0.418  
 0.453 0.409  
8U 0.451 0.417  
 0.456 0.426  
 0.462 0.427  
 0.458 0.418  
 
Die Namen und Werte in der Datei werden durch Tabulatorzeichen getrennt. Der zuletzt 
gewählte Satz wird in der Datei C:\GLOptic\GL_Spectrosoft\default\binning.pbp 
abgespeichert. 
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Die Brightness-Gruppen (Helligkeit) werden in ähnlicher Weise gespeichert. Sie können 

sie unter Verwendung des zweiten Tabs im Bin Editor editieren, sichern und laden. 

 

Bedeutung der Spalten: 
 
1. Gruppenname 
2. Minimaler Helligkeitswert. 
3. Maximaler Helligkeitswert 
 

 

 

Nachfolgend wird das Muster einer Textdateistruktur dargestellt: 
 
JZ 61 71 
KX 71 82 
KY 82 97 
KZ 97 112 
 

Die Namen und Werte in der Datei werden durch Tabulatorzeichen getrennt. Der zuletzt 
gewählte Satz wird in der Datei C:\GLOptic\GL_Spectrosoft\default\brightness.plp 
gespeichert. 
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Wenn Binning- und Helligkeitsgruppen definiert sind werden nach jeder Messung die 
korrekten Namen im Ergebnisfenster angezeigt. 
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7.2 Pass/Fail-Editor 

 

 

Das Pass/Fail-Tool (Tools->Pass/Fail Editor) ermöglicht Ihnen anwenderspezifische 
Bedingungen festzulegen, die das Licht erfüllen muss und die nach jeder Messung 
überprüft werden. 

Bedingungen definieren oder bereits gespeicherte Bedingungen laden und die 
Pass/Fail-Funktion aktivieren. 

 

 

 

  

Pass/Fail Prüfung ein/aus

Auswahl  der zu über- 

wachenden Parameter 

Grenzwerte 

 (min-max ) 

Verwendung 

der aktuellen 

Messung als 

Referenz und 

ähnliche mit 

festgelegter 

Toleranz finden 

Binning und 

Helligkeits 

Überwachung  
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Nach der Messung werden im Results-Fenster und in der Vergleichstabelle die 
Ergebnisse der Pass/Fail Prüfung angezeigt.. 

Jeder Parameter, der zur Überwachung ausgewählt ist, wird wie folgt angezeigt: 

- grün – wenn die Bedingungen erfüllt sind 

- rot – wenn die Bedingungen nicht erfüllt sind. 

Damit erhält der Benutzer detaillierte Informationen welche Parameter nicht die 
gewählten Bedingungen erfüllen. 

 

Zusätzlich zeigt der Pass/Fail-Parameter das Gesamtergebnis der Prüfung 
(PASS/FAIL). Unter Verwendung dieses Parameters und der Vergleichstabelle kann der 
Benutzer die Messergebnisse auf einfache Weise untergliedern und vergleichen. 
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8 Reports 

Ein Report Template ist eine Textdatei im HTML-Format. Es kann in jedem Text- oder 

HTML-Format erzeugt werden. Ein erzeugter Report wird im Standard-HTML-Browser 

geöffnet.  

 
9 Benutzungshinweise 

 

 Stellen Sie sicher, dass die Integrationszeit korrekt dem Pegel der zu prüfenden 
Quelle entspricht. Die besten Ergebnisse werden durch Messung eines Signalpegels 
zwischen 40% und 90% erzielt. Der Signalwert wird nach jeder Messung in der 
oberen Leiste angezeigt. 
 

 Sofern es die empfohlenen Bedingungen und die Messzeit gestatten, sind 
wiederholte Messungen festzulegen. Dadurch kann der Einfluss von Störungen auf 
die Messergebnisse reduziert werden. 
 

 Beim Messen von schmalbandigen Lichtquellen wie z.B. LED, ist ein begrenzter 
Spektralbereich für die Messung festzulegen. Dadurch wird der Einfluss von 
Streulicht auf die Messergebnisse wesentlich verringert. 
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